
CCA- 101: FUNDAMENTALS OF IT & PROGRAMMING 

ASSIGNMENT – 1 

1. What are the four fundamentals parts of computer? Explain it with the help of diagram. 

       There are four fundamental parts of computer 

 CPU ( central processing unit ) 

 Monitor 

 Keyboard &  

 Mouse  

CPU  

A central processing unit (CPU) is the electronic circuitry within a computer that carries out       
the instructions of a computer program by performing the basic arithmetic, logical, control and 
input/output (I/O) operations specified by the instructions.  

 

 

 

 

 

 

 

 

 

 

 

MONITER 

A computer monitor is an output device that displays information in user understandable form. 

 

 

 

 

 

 

 

 

 

 

 



KEYBOARD 

A computer keyboard is an input device that allows a person to enter letters, numbers, and 
other symbols (these are called characters in a keyboard) into a computer. It is one of the most 
used input devices for computers. 

 

 

 

 

 

 

 

 

 

 

MOUSE 

A computer mouse is a hand-held pointing device that detects two-dimensional motion relative 
to a surface. This motion is typically translated into the motion of a pointer on a display, which 
allows a smooth control of the graphical user interface of a computer. 

 

 

 

 

 

 

 

 

 

 

 

2. Discuss about the classification of computers based on size and capacity. 

     Based on size and capacity, computers are classified as follows: 

 Super Computers 

 Mainframe Computers 

 Mini Computers  

 Micro Computers 

SUPER COMPUTERS  

 Supercomputers are the most powerful and physically the largest by size. 

 These are systems designed to process huge amounts of data. 

 The fastest supercomputers can perform over one trillion calculations in a second. 

  Supercomputers have thousands of processors. 



  Because of their extraordinary speed, accuracy and processing power, supercomputers 
are well suited for solving highly complex problems & huge amounts of calculations. 

 Example: JAGUAR, ROADRUNNER etc. 

MAINFRAME COMPUTERS  

 Mainframe computers are very large often filling an entire room and can process 
thousands of millions of instructions per second. 

  In a mainframe environment, users connect to the mainframe through the many 
terminals wired to the mainframe. 

  Mainframes are capable of supporting hundreds to thousands of users simultaneously. 

  Some of the functions performed by a mainframe include: flight scheduling, 
reservations and ticketing for an airline etc. Example: IBM mainframes Z13, IBM System 
z9 mainframe. 

MINI COMPUTERS 

 Minicomputers are much smaller than mainframes. 

  These computers are also less expensive. 

  Sometimes referred to as Midrange Server or Midrange Computer. 

 They are typically larger, more powerful and more expensive than desktop computers. 

 Midrange computers are usually used by small and medium-sized businesses as their 
servers 

 Users connect to the server through a network by using desktop computers. Example: 
Apple iPod, CDC 160A. 

MICRO COMPUTERS 

 Microcomputers are the most frequently used type of computer. 

 It is also, known as Personal Computer (PC). 

  A microcomputer is a small computer system designed to be used by one person at a 
time. Example: Desktop computers, laptops. 

 

3. What is the meaning of computer generation? How many Computer Generations are defined? What 
technologies were/are used? 

MEANING OF COMPUTER GENERATION: 

                      Generation in computer terminology is a change in technology a computer is/was being 
used. Initially, the generation term was used to distinguish between varying hardware technologies. 
Nowadays, generation includes both hardware and software, which together make up an entire 
computer system. There are five computer generations known till date. 

FIRST GENERATION:                       

                           The period of first generation was from 1946-1959. The computers of first generation 
used vacuum tubes as the basic components for memory and circuitry for CPU (Central Processing 
Unit).  

 



SECOND GENERATION: 

                            The period of second generation was from 1959-1965. In this generation, transistors 
were used.  

THIRD GENERATION: 

                          The period of third generation was from 1965-1971. The computers of third generation 
used Integrated Circuits (ICs) in place of transistors. A single IC has many transistors, resistors, and 
capacitors along with the associated circuitry. 

FOURTH GENERATION: 

                            The period of fourth generation was from 1971-1980. Computers of fourth generation 
used Very Large Scale Integrated (VLSI) circuits.  

FIFTH GENERATION: 

                           The period of fifth generation is 1980-till date. In the fifth generation, VLSI 
technology became ULSI (Ultra Large Scale Integration) technology, resulting in the production of 
microprocessor chips having ten million electronic components. 

4. Differentiate between Volatile & Non- Volatile memories. 

TYPES OF MEMORIES: 

Computer memory is of two basic types: 

 Primary memory / Volatile memory 

 Secondary Memory / Non volatile memory 

1) Primary memory / Volatile memory: 

Volatile memory is a computer storage that only maintains its data while the device is powered 
Example: RAM (Random access memory) is volatile. When we are working on a document, it is kept 
in RAM, and if the computer loses power, your work will be lost. 

Random Access Memory (RAM): 

 It is also called as read write memory or the main memory or the primary memory. 

 The programs and data that the CPU requires during execution of a program are stored in 
this memory. 

 It is a volatile memory as the data loses when the power is turned off. 

 RAM is further classified into two types SRAM (Static Random Access Memory) and DRAM 
(Dynamic Random Access Memory). 

2) Secondary memory/ non-volatile memory: 

Nonvolatile memory is a type of computer memory that has the capability to hold saved data 
even if the power is turned off. Example: Read-only memory (ROM), Hard disk, floppy disk etc. 



Read Only Memory (ROM): 

 Stores crucial information essential to operate the system, like the program 
essential to boot the computer. 

 It is non volatile. 

 Always retains its data. 

 Used in embedded systems or where the programming needs no change. 

 Used in calculators and peripheral devices. 

5. Distinguish among system software, application software and open source software on the basis of 
their features. 

SYSTEM SOFTWARE: 

          • It is a type of software that is designed to run a computer's hardware and application programs.  

 Software like operating systems, compilers, editors and drivers etc., come under this category.  

  A computer cannot function without the presence of system software. 

OPRATING SYSTEM: 

 It is system software that manages computer hardware and software resources and provides 
services. 

 Operating system acts as manager of all the resources of computer i.e. resource manager 

OPEN SOURCE SYSTEM: 

 It is a type of computer software in which source code is released under a license in which the 
copyright holder grants users rights to study change and distribute the software to anyone and 
for any purpose. 

 The Linux operating system (OS) is the best-known examples of open source software. 

6. A) Create a file in MS- word to insert a paragraph about yourself and save it with file name yourself       
Describe all steps involved in it. 

Yourself 

I am Thenmozhi, coming from Dharmapuri in the state of Tamilnadu. My father name is M.Marappan, 
he is working at TNEB as a Account Supervisor and my mother name Is Sivagami. She is a house keeper 
and I have two brothers and a sister. Reading books is my Hobby when I have a free time. Now I am 
studying in DR. Ambedkar Government Law College, at Chennai. 

 



Steps involved in this document: 

 First, to create a new word document you click on file and select a new blank document. Then 
you can write in your document. 

 If you want to save your document you can access it later or send it to someone else. 

 If you are used to saving files in other windows programs then it is the same process with word. 
And there is a save menu to save your document. You can also get to the save option from the 
file menu. If  you want to save a copy of your document with different name then you can 
choose a Save As option in the file menu. In the yourself document you will type the name of 
your document. 

6. B) Write steps regarding followings 

 To change the font style 

 To change the font size 

 To change the font color 

 To highlight (in yellow) the line that reads “need to get IMS s address. 

TO CHANGE THE FONT STYLE: 

 First, select the text you want to modify.  

  Click on font style box on the Home tab. The font style drop-down menu appears.  

  Then move your cursor over the various font styles.  

 Left-click the font style you want to use.  

  Then font style will change in the document. 

TO CHANGE THE FONT SIZE: 

 Select the text you want to modify.  

 Click on font size box in the Font group on the Home tab. The font size drop-down menu 

appears.  

 Move your cursor over the various font sizes.  

  Left-click on font size you want to use.  

 Then it will change font size in your document. 

TO CHANGE THE FONT COLOUR: 

 Select the text you want to modify. 

  Click on the font color box on the Home tab. The font color menu appears.  



 Move your cursor over the various font colors.  

  Left-click the font color you want to use.  

 Then font color will change in the document. 

TO HIGHLIGHT IN YELLOW: 

Need to get IMS’s address 

7. Create a file in MS- word for the following document and save it with file name ‘ms-word’. Describe all 
steps involved in it.  

MS Word 

MS Word is a widely used commercial word processor developed by Microsoft. 

MS word is application software, which is capable of 

 creating, 

 Editing, 

 Saving, and 

 Printing any type of document 

STEPS INVOLVED IN THIS DOCUMENT: 

 First you select the text want to modify. 

 Click on the font color command on the home tab. 

 After that move your cursor over the different colors.  

 Then you choose color what you want and click on color as you select. 

 Finally the text color will change. 

 To underline the text, select the text you want to modify and click on the underline command in 
the font group. 

 Then the text will change as you want. 

 To strikethrough the text, first you select the text want to modify.  

 Click on the strikethrough command. Then it will change as a Strikethrough. 

 To change the text as a bold form, select the text you want to modify.  

 Click on the bold command in the font group on the home tab. Then text will change as bold 
letters.  

8. Create a file in MS- word for the following document and save it with file name ‘equations’. Describe 
all steps involved in it. 

EQUATIONS 



X2 + Y5 = 30 

Z3 + Q4 = 50 

A2 + B8 = X2 + Y8 

TO CHANGE A TEXT AS SUBSCRIPT 

o First you select the text want to modify. 

o If you want to create small letters below the text baseline, then click on the subscript command 
on the home tab. 

o Then it will change as a subscript in the document or text. 

o If you want to create a small letter just above the baseline of text, again you just click on the 
subscript command on the home tab, finally it will change as a subscript. 

9. Create a file in MS- word that convert existing highlight text to table as shown below and save it as file 
name ‘text_ to _table’. Describe all steps involved in it. 

Select the text you want to convert. 

Select the Insert tab. 

Click on Table command. A dialog box appears. 

Click on Convert text to table, a new dialog box appears 

Here set number of columns.  

Click on OK finally selected text convert in a table.  

Text to table 

Select the text you want to convert. Select the Insert tab. 

Click on Table command. A dialog box 
appears. 

Click on Convert Text to Table, a new 
dialog box. 

here set number of columns. Click on ok finally selected text 

convert in a table. 

Steps involved in the document 

 If you want to change a text as a table, first you have to select the text you want to modify or 
convert as a table.  

 Then select the insert tab, click on the table command. 

 



 Then the dialog box will appears.  

 Then click on the convert text to table after that click your left, a new dialog box will appears 
there. 

 Then you have to set a number how many columns you want.  

 After finishing that step click OK. 

 Finally the selected text will convert as a table. 

10. Create a file in MS- Word to insert a table in the document. Describe all steps involved in it. 

          

          

          

          

          

          

          

          

          

           To insert a new table in your work sheet follow these steps 

 First place your insertion point in your document where you want to insert the table,  

 Then select the insert tab click on the table command, then drag your mouse over the diagram 
to select the number of columns and rows as you need,  

 Finally left click your mouse table will appears in your document then you can text inside of the 
table as you want. 

11. Create a following worksheet in MS- excel and save it with name ‘book1’. 

This is home page if excel where you can click on blank workbook and the screen that appears is nothing 
is but your excel workbook. First thing to notice is the name of the worksheet. Excel by default save it as 
book 1. 

Roll no  Name Marks 

1 n1 60 

2 n2 70 

3 n3 80 

4 n4 90 

5 n5 40 

6 n6 50 

7 n7 77 

8 n8 44 

9 n9 88 



10 n10 55 

 

12. Calculate the following things of a range (C2:C11) of data in the worksheet created in question no 
10. 

 the sum of the marks using AutoSum in a range of cells (C2:C11) 

 average of the marks in a range of cells (C2:C11) 

 highest marks in the range of cells (C2:C11) 

 minimum marks in a range of cells (C2:C11) 

1 The sum of the marks using AutoSum in a range of cells (C2:C11) 

Select Cells and type formula in =SUM (C2:C11) 

2. Average of the marks in a range of cells (C2:C11) 

Select cells marks and select target cell formula = AVG (C2:C11) 

3. Highest marks in a range of cells 

Select range and select target cell =Max (C2:C11) 

4. Minimum marks in a range of cells (C2:C11) 

Select range and select target =Min (C2:C11) 

13 a) Describe various steps involved in the following 

 To modify column width of a worksheet  

 To modify the row height of a worksheet 

 To delete rows and columns of a worksheet 

TO MODIFY COLUMN WIDTH OF A WORKSHEET 

 Position the cursor over the column line in the column heading, 

  And a double arrow will appear. 

  Left-click the mouse, then drag the cursor to the right to increase the column width or to the 
left to decrease the column width. 

  Release the mouse button. 

TO MODIFY THE ROW HEIGHT OF A WORKSHEET 

 Position the cursor over the row line you want to modify, 



  And a double arrow will appear 

  Left-click the mouse, then drag the cursor upward to decrease the row height or downward to 
increase the row height 

   Release the mouse button. 

TO DELETE ROWS AND COLUMNS OF A WORKSHEET 

 Select the row or column you want to delete. 

 Click the Delete command in the Cells group on the Home tab.  

 Selected column or row deleted. 

13 b) Describe following terms in the worksheet 

 Absolute reference and relative reference in formula 

Absolute reference 

 Absolute references do not change when copied or filled. You can use an absolute reference to 
keep a row and/or column constant. 

Relative reference  

By default, all cell references are relative references. When copied across multiple cells, they 
change based on the relative position of rows and columns. For example, if you copy the 
formula =A1+B1 from row 1 to row 2, the formula will become =A2+B2. Relative references are 
especially convenient whenever you need to repeat the same calculation across multiple rows 
or columns. 

 Cell address 

A cell reference in Excel refers to the value of a different cell or cell range on the current worksheet 
or a different worksheet within the spreadsheet. A cell reference can be used as a variable in a 
formula. 

14 a) What tools are available to customize our PowerPoint presentation? 

I. Crop pictures to fit shapes of pictures 

II. You can play music in the background of your presentation 

III. Combine shapes to create a custom shape 

IV. You can add sound effects to Animations 

V. Remove the background from a picture 

VI. You can insert a screenshot or screen clipping to presentation 

VII. You can also embed other videos 

14 b) write the steps for the following action for creation of power point presentation 



 Open a Blank presentation 

 Save the presentation as Lab1.pptx 

 Add a Title to the first slide: the name of your college 

 Type your first name and last name in the Subtitle section 

 Add a New Slide which has a Title and Content 

OPEN A BLANK PRESENTATION 

I. Select the File tab to go to Back Stage view. 

II. Select New on the left side of the window, click Blank Presentation. 

III. A new presentation will appear.  

SAVE THE PRESENTATION AS LAB1. PPTX 

I. Click on the File tab to launch the Backstage view and select Save 

II. In the Save As dialog, type in the file name and click "Save". 

The default file format is pptx. If you want to save the file with a different name, choose one of the file 
types from the "Save as type" dropdown list. 

ADD A TITLE TO THE FIRST SLIDE: THE NAME OF YOUR COLLEGE 

I. Select the slide whose layout you will change so that it can have a title. 

II. Click Home > Layout. 

III. Select Title Slide for a standalone title page or select Title and Content for a slide that contains 
a title and a full slide text box. ... 

IV. Select the Click to add title text box. 

V. And after that I type name of my college that is Dr. Ambedkar govt law college.  

TYPE YOUR FIRST NAME AND LAST NAME IN THE SUBTITLE SECTION 

I. Right-click between slides and select Add Section. An Untitled Section is added in the thumbnail 
pane. 

II. Right-click the Untitled Section and then select Rename Section. 

III. Type a name as my name is Thenmozhi Marappan in the Section name box. 

IV. Select Rename. 

V. To collapse a section, click the triangle next to the section name. 

ADD A NEW SLIDE WHICH HAS A TITLE AND CONTENT 

I. Right-click between slides and select Add Section. An Untitled Section is added in the thumbnail 
pane. 

II. Right-click the Untitled Section and then select Rename Section. 

III. Type a name in the Section name box. 

IV. Select Rename. 

V. To collapse a section, click the triangle next to the section name. 



15. Write steps for creation of a set of Power Point slides that demonstrates your skill to use the tools 
of PowerPoint. It is should include the following things 

 Title slide & bullet list 

 Inserting Excel Sheet 

 Click art and Text 

 Slide show effects 

TITLE SLIDE & BULLET LIST  

 Click on new slide from the home tab. A list of thumbnails appears, outlining your various slide 
content options to choose from. 

 Click once on the appropriate thumbnail to bring up the next slide. 

To enter bullets: 

 Bullets appear automatically on each line. 

 Press Enter to bring a next bullet. 

 To erase an unwanted bullet, click next to the bullet and press the Backspace key. 

 TO indent a bullet ( to make a sub point), press tab 

 To undo an indent, press together with the shift key. 

INSERTING EXCEL SHEET 

 Click once anywhere inside the chart to select it. This launches a chart tools contextual 
command tab that doesn’t appear on the normal editing screen. 

 Make sure the design tab under the chart tools is selected and then click on edit data from the 
group. 

CLICK ART AND TEXT 

 Right-mouse click inside the shape. 

 Select edit text  

 Right Enter your text. 

 Click on the insert tab and choose clip art from illustrations group. 

SLIDE SHOW EFFECTS 

 Click on the animation tab. 

 Glide your mouse over each of the transition effects located in the transition to this slide group 
to preview them on your slide. 

 Note the vertical scroll bar to the right, there are more effects to preview than are currently in 
the view. 

 Click once on effect to select it. 



 To apply the transition to the entire presentation, click on apply to all. 

Part- 2 

16. What is the difference between Machine Language and High Level Language? 

Machine Language High Level Language 

1. Machine language is very difficult to 
understood by the human beings 

It is easy to understand 

2. It does not need to be translated. It is needs to be translated into machine code. 

3. It is the only language that is directly 
understood by computer 

High level language cannot be understood 
directly by a computer. 

4. All instructions use binary notation and 
are written as a string of 1s and 0s. 

It is a programming language that uses English 
and mathematical symbols, like +, -, % and 
many others, in its instructions. 

5. A program instruction in machine 
language may look something like this: 

10010101100101001111101010011011100101 

 

The instruction in a high-level computer 
language would look something like this: 

x = 100 
if balance  x: 
 print 'Insufficient balance' 
else: 
 print 'Please take your money' 
This is not exactly how real people 
communicate, but it is much easier to follow 
than a series of 1s and 0s in binary code. 

 

 

17. Discuss about different data types of C programming Language. 

Data types in C Language 

I. Primary data types: 

These are fundamental data types in C namely integer( int ), floating            
point( float ), character( char ) and void . 

II. Derived data types: 

Derived data types are nothing but primary datatypes but a little twisted or grouped together 
like array, Stucture, union and pointer. 

18. Find output of the following expressions 

a) X= 20/5*2+30-5   

    =4*2+30- 5 



    =8+ 30- 5 

    =38-5 

    X=33                 

b) Y=30- (40/10+6) +10   

  =30- (4+6)+10 

  =30- 10+ 10 

  =20+10 

 Y =30        

c) Z=40*2/10-2+10 

  =80/10-2+10 

  =8-2+10    =6+10 

Z= 16 

 

19. Describe the syntax of the following statements 

a) If – else statement  

An if statement can be followed by an optional else statement, which executes when the 
Boolean expression is false. 

Syntax 

The syntax of an if...else statement in C programming language is − 

if(boolean_expression) { 
   /* statement(s) will execute if the boolean expression is true */ 
} else { 
   /* statement(s) will execute if the boolean expression is false */ 
} 

If the Boolean expression evaluates to true, then the if block will be executed, otherwise, the else 
block will be executed. 

C programming language assumes any non-zero and non-null values as true, and if it is 
either zero or null, then it is assumed as false value. 

 

b) For loop  

A for loop is a repetition control structure that allows you to efficiently write a loop that needs 
to execute a specific number of times. 

Syntax 

The syntax of a for loop in C programming language is − 



for ( init; condition; increment ) { 
   statement(s); 
} 

c) While loop  

A while loop in C programming repeatedly executes a target statement as long as a given 
condition is true. 

Syntax 

The syntax of a while loop in C programming language is − 

while(condition) { 
   statement(s); 
} 
Here, statement(s) may be a single statement or a block of statements. The condition may be 
any expression, and true is any nonzero value. The loop iterates while the condition is true. 
When the condition becomes false, the program control passes to the line immediately 
following the loop. 

d) Do – while loop 

Unlike for and while loops, which test the loop condition at the top of the loop, 
the do...while loop in C programming checks its condition at the bottom of the loop. 

A do...while loop is similar to a while loop, except the fact that it is guaranteed to execute at 
least one time. 

Syntax 

The syntax of a do...while loop in C programming language is − 

do { 
   statement(s); 

} while( condition ); 

20. Find the output of the following program segments. 

a)  

#include <stdio.h> 

 int main() 

{ 

 int i; 

 for (i=1; i<2; i++) 

{ 

   printf("IMS Ghaziabad\n"); 

  } 



} 

Output: IMS Ghaziabad 

b) 

     #include <stdio.h> 

      int main()  

    {  

       int i = 1;  

       while ( i <= 2 )  

        { 

          printf( "IMS Ghaziabad\n"); 

          i = i + 1; 

         } 

 

Getchar(); 

Return 0; 

} 

Output: 

IMS Ghaziabad 

IMS Ghaziabad 

IMS Ghaziabad 

C)   

#include <stdio.h> 

 void main()  

{ 

 int a = 10, b=100;  

if( a > b ) 

 printf( "Largest number is %d\n”, a); 

 else 

 printf( "Largest number is %d\n”, b); 

} 

Output : Largest number is 100 


